Join Kermit™ as Captain Smollett and his Muppet™ crew on
the adventure of a lifetime! Visit new lands, meet swashbuckling
I pirates, and discover a treasure-

trove of puzzles and activitics in

this interactive treasure hunt!
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WELCOME TO MUPPET TREASURE ISLAND™

Ahoy, matey! Welcome to Muppet Treasure Island, the epic adventure game for
the whole family. Muppet Treasure Island has something for everyone — laughs,
chills, puzzles, activities, hotspots and an engaging storyline starring you and your
favorite Muppets™. With a never-before-seen blend of video and animation, Muppet
Treasure Island offers an interactive experience like no other.
With Muppet Treasure Island, you become the adventure hero— “Hawkins”. Join
Billy Bones at the Benbow Inn to hear tales of pirates and treasure. In Bristol, seek
out the Squire and gain passage aboard the Hispaniola. Onboard the ship, become
“one of the crew and complete the captain’s chore list. And finally, navigate the ship
to Treasure Island, where more adventure, Muppets and treasure await!

To get started you will first need to install your version of Muppet Treasure Island:
Windows 95, Windows 3.1x or Macintosh. Please go to the appropriate section on
installing and follow the instructions. Once you have completed the installation, go
to the “Getting Started” and “GamePlay” sections for explanations of the opening
title screen and how to play the game.

So climb aboard with Captain Smollett and friends, and set sail for adventure. Set
sail for Muppet Treasure Island!
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INSTALLING MUPPET TREASURE ISLAND
FOrR WINDOWS® 95

MINIMUM SYSTEM REQUIREMENTS

¢ 100% Windows 95-compatible computer (including 32-bit Windows 95-
compatible drivers for CD-ROM drive, video card, sound card and input devices)

¢ 486 DX2/66 MHz processor with 8 MB of physical RAM

¢ Double-speed CD-ROM drive (300K/second sustained transfer rate)
e 35 MB of uncompressed hard disk space

¢ 15 MB for virtual memory recommended

¢ VESA local bus (VLB) or PCI video

* 256-color SVGA (640 x 480)

e 100% Microéoft'-compatible mouse and driver

* 100% Sound Blaster-compatible sound card

¢ Video for Windows and Indeo® video interactive R4.1 (included)
* Microsoft Windows 95 operating system

* 100% Windows 95-compatible printer (optional)

Note: This product requires an English language operating system to run. For
information on versions of this product localized to work with non-English
operating systems, please contact Activision.
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BEFORE INSTALLING THE WINDOWS 95 VERSION

Please make sure your computer system is 100% Windows 95-compatible; Muppet
Treasure Island for Windows 95 is not compatible with Windows 3.1x. If your
computer is operating under Windows 3.1x, please see the installation instructions
for Windows 3.1x on page 9.

For Muppet Treasure Island for Windows 95 to operate best, it requires that your
system have the latest Windows 95 32-bit drivers for your CD-ROM drive, sound
card and video card, as well as any other peripherals you want to use. If you have
any problems running the program, older drivers are a likely cause.

If you need help on how to obtain the latest sound and video drivers, check out the
Muppet Treasure Island Help file. Just click the MORE button on the title screen
(which displays shortly after inserting Disc 1 into your CD-ROM drive), then click
the HELP button. We have supplied a list of major computer hardware companies
and their telephone numbers. You can find them listed under “Vendor List.” This
file has a lot of other helpful information on installation and system setup, as well
as game-specific technical help.
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How 1O INSTALL THE WINDOWS 95 VERSION

1. Before installing, close all other applications and turn off your screen saver and
file sharing. Set the taskbar so that it is not always on top.

2. Insert Muppet Treasure Island Disec 1 into your CD-ROM drive and wait a few
moments until the Muppet Treasure Island title screen appears. If the title
screen does not appear, please refer to the “Troubleshooting” section on the
next page.

3. There are three buttons on the title screen. Click the INSTALL button to begin
the installation process and then follow the on-screen instructions.

After Muppet Treasure Island setup is complete, your computer will install Micro-
soft’s Video for Windows and Intel’s Indeo video drivers if you do not already have
them. After installing the new drivers, you will need to restart your computer for
them to take effect. For more information on Video for Windows or Indeo, refer to
the “Video for Windows” section in the Muppet Treasure Island Help file.

Now you can run Muppet Treasure Island by choosing Programs\Muppet
Treasure Island\Muppet Treasure Island from the Start menu.

For an explanation of the opening title screen and how to play the game, see the
“Getting Started” and “GamePlay” sections.

Don'’t forget to register your copy of Muppet Treasure Island electronically. See
page 12 for instructions. :
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TROUBLESHOOTING

If the Muppet Treasure Island title screen does not appear, try performing the

following steps:

1. Double-click on the My Computer icon on your desktop or right-click on the
icon and choose the Open option.

2. Select the Refresh option located in the View pull-down menu.

3. Double-click on the Muppet Treasure Island MTI1 icon in the window or right-
click on the icon and choose the AutoPlay option.

4. After the Muppet Treasure Island title screen appears, click the INSTALL or
PLAY button.

If the AutoPlay feature does not function, please check the following:

1. Make sure the CD is clean and properly placed in the CD-ROM drive.

2. Perform the following steps to verify your CD-ROM driver has been optimized
for use with Windows 95.
a. Open the Windows 95 Control Panel folder and double-click on the System

icon. :

b. Click on the Performance tab. If any of your hardware drivers are not fully

optimized for use with Windows 95, they will be listed here with an explana-
tion of the exact problem and suggestions on how to fix it.

Windows 95 6

3. Verify that the Auto insert notification for your CD-ROM is enabled. To do this:
a. Open the Windows 95 Control Panel folder and double-click on the System
icon.
b. Click on the Device Manager tab. Your system’s devices will be listed here.
Click on the + (plus sign) symbol that appears next to the CD-ROM listing.
Double-click on the CD-ROM make and model that is on your system.

¢. Click on the Settings tab. Under Options there will be a check-box labeled
Auto insert notification. Make sure this box is checked. Click OK.

4. You may have a CD-ROM drive that does not offer AutoPlay support. Contact
your CD-ROM manufacturer for more information.
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INSTALLING MUPPET TREASURE ISLAND
For WINDOWS® 3.1Xx
MINIMUM SYSTEM REQUIREMENTS

100% Windows 3.1x-compatible computer

486 DX2/66 MHz processor with 8 MB of physical RAM

Double-speed CD-ROM drive (300K/second sustained transfer rate)

35 MB of uncompressed hard disk space

15 MB for virtual memory recommended

VESA local bus (VLB) or PCI video

256-color SVGA (640 x 480)

100% Microsoft-compatible mouse and driver

100% Sound Blaster-compatible sound card

WinG, Video for Windows and Indeo® video interactive R4.1 (included)
Microsoft MS-DOS® 6.2x operating system; plus Microsoft Windows 3.1x

100% Windows 3.1x-compatible printer (optional)

Note: This program uses new multimedia Windozws technologies (WinG, Micro-
soft’s Video for Windows and Intel’s Indeo), that may require your system to have
the latest Windows sound and video drivers.

Also note: This product requires an English language operating system to run.
For information on versions of this product localized to work with non-English
operating systems, please contact Activision.

Windows 3.1x -]

® ®© o ©o ® o o o o o o o

How TO INSTALL THE WINDOWS 3.1X VERSION

1. Before installing, close all other applications and turn off your screen saver and
file sharing.

2. Insert the Muppet Treasure Island Dise 1 into your CD-ROM drive. Select Run
from the File menu in your program manager. Type DAINSTALL.EXE (where
D: is your CD-ROM drive) and click OK. The Muppet Treasure Island title
screen will appear.

3. There are three buttons on the title screen. Click the INSTALL button to begin
the installation process and then follow the on-screen instructions.

After Muppet Treasure Island setup is complete, your computer will install WinG,
Microsoft’s Video for Windows and Intel’s Indeo video drivers if you do not already
have them. After installing the new drivers, you will need to restart your computer
for them to take effect. For more information on WinG, Video for Windows or
Indeo video, see the “Video for Windows” section in the Muppet Treasure Island
Help file.

Now you can run Muppet Treasure Island by double-clicking the Muppet Treasure
Island program group in your Program Manager, and double-clicking the Muppet
Treasure Island icon.

For an explanation of the opening title screen and how to play the game, see the
“Getting Started” and “GamePlay” sections.

Don't forget to register your copy of Muppet Treasure Island electronically. See
page 12 for instructions.
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INSTALLING MUPPET TREASURE ISLAND
FOR MACINTOSH

MINIMUM SYSTEM REQUIREMENTS

Macintosh or 100% compatible

68LC040-66/33 MHz or any PowerPC processor

RAM requirements:

— 68LC040 — 8 MB built-in (requires 5.8 MB free)

— PowerPC — 8 MB built-in (requires 5.8 MB free) and 8 MB virtual memory
— 16 MB Built-in RAM recommended

Double-speed CD-ROM drive (300K/second sustained transfer rate)

35 MB of uncompressed hard disk space (plus an additional 16 MB if virtual
memory is used)

256-color (640 x 480)

13" color monitor

System 7.5.1

QuickTime™ 2.1, Sound Manager 3.1, Indeo Video 3.2; QuickTime™ Musical
Instruments 2.1, and QuickTime PowerPlug™ 2.1 (PowerPC only)’

100% Macintosh-compatible printer (optional)

"These extensions are included.

Macintosh 10

How TO INSTALL THE MACINTOSH VERSION

1. Before installing, close all other applications and turn off your screen saver and
file sharing. We recommend turning on Modern Memory Manager if you have it.

2. Insert the Muppet Treasure Island Dise 1 into your CD-ROM drive. Double-
click on the CD icon. From the CD window, double-click the Install Muppet
Treasure Island icon. The Muppet Treasure Island title screen will appear.

3. There are three buttons on the title screen. Click the INSTALL button to begin
the installation process and then follow the on-screen instructions.

After Muppet Treasure Island setup is complete, your computer will install the
QuickTime™ 2.1, Sound Manager 3.1 and Indeo Video 3.2 extensions if you do not
already have them. After installing these extensions, you will need to restart your
computer for them to take effect. For more information on any of these extensions,
see the “About the Macintosh Version” section in the MTI Help file.

Now you can run Muppet Treasure Island by choosing the Muppet Treasure
Island icon from the Muppet Treasure Island folder on your hard disk drive and
then click PLAY on the title screen.

For an explanation of the opening title screen and how to play the game, see the
“Getting Started” and “GamePlay” sections.

Don’t forget to register your copy of Muppet Treasure Island electronically. See
page 12 for instructions.
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ELECTRONIC REGISTRATION
(FOR NORTH AMERICAN RESIDENTS ONLY)

REGISTER YOUR COPY OF MUPPET TREASURE ISLAND
FOR WINDOWS 95, WINDOWS 3.1X OR MACINTOSH

To make it fast and easy, you can use our Electronic Registration system (North
America only). From the Muppet Treasure Island title screen, click on MORE,
and then click on REGISTRATION. A second way for Windows 95 users is to
right-click on the Muppet Treasure Island CD icon while Disc 1 is in the
CD-ROM drive and select Registration from the menu.

1. By selecting Register Now, the registration window will appear.
. Please fill in all requested information accurately.
Note: Use the mouse or tab key to select the desired fields.

n

. The registration program will detect your computer’s configuration.

wm o W

. You will then be presented with three options. You will be able to register via
modem or print out the registration form and send it to us via fax or mail. Once

12

. After the registration window has been completely filled in, click the OK button.

you print, you will find Activision’s fax number and mailing address on the top
portion of the page. The third option is Register Later. By selecting this option
you will be able to register at a later time.

6. If you use this electronic registration process and are able to register success-
fully, there is no need to send in the printed registration card (attached to this

manual).

GETTING STARTED

Once you've installed, simply select PLAY from the title screen to begin playing.
From the title screen you can also select QUIT to exit the game and MORE, which
will give you the following options:

HELP — Takes you to the Muppet Treasure Island Help file.

REGISTRATION — Allows you to register your copy of Muppet Treasure
Island electronically.

TEST — Allows you to test your sound before you play the game.
LESS — Takes you back to the three button title screen.

UNINSTALL — Allows you to delete all Muppet Treasure Island files
(in Windows only).
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If you have just installed the game and this is your first time playing, you will
automatically be led into a new game. If this is not your first time playing, you will
be taken Backstage where you will have the following options:

NEW GAME — Starts a new game from the beginning.

LOAD — Loads a previously saved game.

QUIT — Exits Muppet Treasure Island.
You can also explore any one of the four Muppet Treasure Island worlds (Benbow
Inn, Bristol, the Hispaniola or Treasure Island) by clicking the appropriate logo on
the mini-television screens.

GAMEPLAY
STEVENSON, YOUR ADVENTURE PARROT AND INVENTORY

Stevenson the Parrot is your friendly companion throughout your Muppet
Treasure Island adventure. He flies to your shoulder to offer helpful hints and is
always accessible from a nearby perch in each view. Click once on Stevenson to get
wisecracks or hints on activities and goals.

If you double-click on Stevenson during the game (or press Ese on the keyboard),
you will find, under his wing, an inventory of various objects you may have picked
up during gameplay along with the following options:
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Quit — Click here to exit the game and return Backstage. To
return to your desktop, you must also click on the QUIT lever
Backstage

MPZ-1000 — Click on the MPZ-1000 to display the above
screen. From this quad-monitor control center, every view of
the game can be printed out for coloring, collecting or framing
Select a world by clicking the roundish button, and use the left
and right arrows to scroll through scenes from that world
Seleet the black-and-white flower icon if you wish a black-and-
white version of a scene, and select the color flower icon if you
wish to print out a color version. Click on the ? (question
mark) if vou want help.
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SAVE — Click on the
Save Disk to display the
above screen. Drop the
View icon into any of the
slots to save your game.
You can then return to
this exact spot in the
game in the future
Dropping an icon onto a
previously saved game
will overwrite that game
LOAD — Click on the
Load Disk to display the
above screen. Click on
the view of a previous
game to which you'd like
to return

RATCORDER — Click
on the ratcorder to
display the screen to
the left. Choose one of
eight original songs the
Tourist Rats have
provided for your
listening pleasure




GAME INTERFACE

HoTtspoTts
Hotspots are active areas in each view that you can click on. There are three
kinds of hotspots in the game.

Action Hotspots

When clicked on, these will trigger an audio and/or video response (e.g., lightning
strike, flying dishes) or a Muppets video clip. When you place your cursor over an
action hotspot, the area will highlight and a pointed hand cursor will appear.
Many action hotspots have multiple responses.

Moveable Hotspots

These are objects that you can pick up (e.g., objects in the sea chest). Moveable
hotspots do not highlight and are indicated by an open hand cursor.

Navigational Hotspots

These are areas on the screen on which you click in order to move to a different
view. They are most often found in doors, windows, pathways and the screen
borders. Navigational hotspots do not highlight and are indicated by one of the six
arrow-shaped navigational cursors.

16
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CURSORS

Indicates a hotspot where you can see something happen (e.g., lightning
strike) or view a Muppets video clip. Many hotspots have multiple responses.

Indicates that you can hear a musical selection (usually located in the upper
left corner of a scene).

Indicates an object you can pick up.

Appears when you drag an object.

Used on Treasure Island to bonk pirates.

Indicates that you can move up to another scene.

Indicates that you can move down to another scene.
Indicates that you can move left to another scene.
Indicates that you can move right to another scene.
Indicates that you can move forward to another scene.
Indicates that you can move backward to another scene.
Indicates a neutral area. (A mouse-click here has no effect.)

Indicates that you must wait for action to continue.

17




KEYBOARD SHORTCUTS

Spacebar — Skips past audio, video and animation clips.

Esc — Shows the Inventory under Stevenson’s wing.

S — Saves the game so that you can start from the location where you saved.
L. — Loads a saved game.

Cmd +Q — Quits the game in Macintosh.

Alt+F4 — Quits the game in Windows.

MOoUSE

The mouse is your primary method for interacting with the game. Mouse clicks give

different messages to the game.

Single-Click: ~ Activates a hot spot, initiates a navigation command, brings
Stevenson to your aid, or activates Inventory objects.

Drag-n-Drop: Click and hold the mouse button down while dragging an object to a
specific location to drop (e.g., dragging the key to the sea chest
lock).

IntelliDrag:  Certain objects can be single-clicked to move them to their correct
positions automatically. ‘

Double-Click: Double-click on Stevenson to view what’s under his wing.
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HEeLPFUL HINTS TO GAME ACTIVITIES

BENBOW INN
Goal: Find Captain Flint's treasure map.
To find the map to Treasure Island, look in the sea chest in Billy Bones’ bedroom

after first finding the sea chest key, which is hidden somewhere in or around the
Benbow Inn.

BRISTOL

Goal: Board a ship bound for treasure.

e In order to get aboard the ship, you need to acquire the Seal of Passage from
Squire Trelawney, son of the Bristol's master shipbuilder. Before the butler will
let you in to see the Squire, you must be dressed in a “Monsieur Edouard”
original. In order to buy a Monsieur Edouard original, you need to earn some
money. And the only way you can earn some money is by helping Pops shoot
pies at pirates at Pops’ Potpourri.

¢ Pops’ Potpourri Pie Shoot — Drag-n-drop or IntelliDrag the pies to pick them up
and drop them onto the center of the pie launcher. Click the red button to fire
the pie at the pirates as they peek into Pops’ store. He will reward you one
doubloon for every pirate you hit, and he'll dock you one doubloon for every
customer you hit.

¢ Monsieur Edouard the Clothes Horse — Once you've earned enough money,
you can go next door to purchase a new outfit.
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* Player Piano — You can play your own music on the piano in the Spyglass Inn
by clicking the keys, or you can select one of the pink or green song buttons
above the keyboard to start the player piano. To play a full son$, you must
imitate the player piano note for note until it begins to play by itself. The red
button on the lower right side of the piano stops the player piano. The :
instrument display allows you to select an instrument that you want the piano to

imitate.
Note: In order to enter the Spyglass Inn, you must wear an eyepatch that matches
your outfit.

THE HiSPANIOLA

Goal: Sail the ship to Treasure Island.

You must complete five chores for Captain Smollett in order to earn the reward of

steering the Hispaniola to Treasure Island:

e Build Your Own Model Ship — In Captain Smollett’s cabin, find pieces of the
Hispaniola ship model in the drawers on the right. Open the drawers in any
order and select parts of the ship to attach. Captain Smollett will tell you ab.out
each piece. Once you've assembled the entire ship, you can rotate it to see it
from every angle.

While you're in Captain Smollett’s cabin, you can also play Shanghai on hi§ dfzsk.
Click on matching pairs of tiles that are free on the left or right side; you win if
you can match every tile. If you get stuck and can’t make another move, you can
clear the tiles and play again by clicking the reset button on the Captain’s desk.
Note: Playing Shanghai is not one of the chores on Captain Smollett’s list.
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* Fire the Cannon — Pick up or single-click objects in the barrel and drop them
on the loading pad to be vacuumed and loaded into the cannon. Click the red
button on the cannon to fire the ammo. Aim the cannon with the arrows on the
bottom of the cannon. Try to hit at least three of the targets floating by.

* Weigh the Anchor — At the bow, click the down-arrow on the post, and drop the
anchor several times to see what surprises you drag up (by clicking the up-arrow).

* Load the Jolly Boat — Help Gonzo™ load barrels into the jolly boat by picking up
the barrels as he passes by overhead, and then dropping them on his hook nose.
After you've filled the jolly boat, you can move on to the next task.

* Help Long John Silver in the Galley — Pick up the red apples as they roll out of
the barrel on the right and drop them into the pie shell on the center counter.
Rizzo™ will try to eat the apples, but if you're fast enough, you can fill the pie
shell before he eats them all. Ring the bell on the right to let Long John know
that you've finished.

After you have completed all your tasks, the Captain will invite you to the top of
the helm for an astronomy lesson at nightfall. Click on adjacent stars to form a
constellation and hear a tale or two about that constellation. You can return here
for another version of stories, and you might also want to explore the Captain’s
cabin before you're escorted below deck for the night.

When morning dawns, you will be asked to steer the Hispaniola to Treasure Island.
After you have safely done this, go back down to the main deck.

Note: Your chore list is posted on the main mast as you face the helm. You can
always check on your status by clicking on it.
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TREASURE ISLAND
Goal: Find the hidden treasure.

Flint's Folly: Folly Rocks — Correctly arrange four rocks (North, South, East,
West), and you're a step closer to unlocking the treasure cave.

Note: You must have first found the rocks — one of them is in each of the worlds,
and, if you miss them there, you can also find all of them on the island.

Flint's Folly: Coin Game — Click the arrows to move the gold coins into the
center square.

Decode the Secret Password — After you have solved Flint’s Folly, you will be
able to get into the treasure cave, where there are treasure chests and skulls.
After you've opened a few chests, you'll be able to move to the right of the cave.
Click on the bottom skull to hear the secret password and then click on the other
skulls to form the sentence that will open the door to Benjamina's hut.

Benjamina's Shell Game — Click the seashells framing the mirror on Queen
Benjamina'’s vanity. When you match a pair of her favorite gems (one from the
left side, and then one from the right), a door will open revealing her secret
treasure chamber. :

Move the Treasure to the Hispaniola — In order to move the treasure to the
ship, point your cursor to the treasure and click your mouse. You must then
move the treasure onto the ship by raising the Union Jack. To do this, bonk the
pirates with your coconut cursor. Everytime you hit a pirate, the Jolly Roger will

W
w

move down a notch. When it is all the way down, the Union Jack will go up the
flagpole and you can then click the treasure to move it onto the Hispaniola.

* Before you climb aboard the ship, check out the treasure inside the chest that
appears on the beach.

TeCHNICAL HELP

There are several ways that you can access the Muppet Treasure Island Help file:

1. From the title screen, select MORE, then select HELP to access our contact-
sensitive technical help file.

2. Double-click the Muppet Treasure Island Help icon on the CD-ROM disc drive,
or on your hard drive in the Muppet Treasure Island folder.

3. (Windows 95 only) With Dise 1 in your CD-ROM drive, right-click on the CD
drive icon and select Troubleshooting.

4. (Windows 95 only) From your Start menu, select \Programs\Muppet Treasure
Island\Muppets Treasure Island Help File.

5. (Windows 3.1x only) Select Muppet Treasure Island Help file from the Muppet
Treasure Island program group in your Program Manager.
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CUSTOMER SUPPORT

Before contacting customer support, please consult the Muppet Treasure Island
Help file. It contains the answers to some of our most frequently asked questions
and may quickly and easily provide a solution to your difficulty. If after reviewing
the Muppet Treasure Island Help file you are still experiencing problems, please
feel free to contact us through any of the services listed.

So that we can better assist you, please be at your computer and have the following
information ready:

1
2. Exact error message reported (if any) and a brief deseription of the problem

3

4. Video and sound card makes and models (e.g., Diamond Stealth 64 video, Sound

Complete product title
Your computer’s processor type and speed (e.g., Pentium 90, 68LC040-66/33...)

Blaster 16 sound)

CUSTOMER SUPPORT IN THE U.S.
ONLINE

Services with Activision Forums, E-Mail and File Library Support

 Microsoft Network: From any MSN window, pull down the Edit menu
and select Go to then Other Location. At the prompt, type “Activision”
and click OK.

e America Online: Use keyword “Activision” to locate the Activision forum.
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e CompuServe: 76004,2122 or [GO GAMBPUB]
e Activision BBS: (310) 479-1335 Up to 28,800 Baud;
Settings: 8 Bits, No Parity, 1 Stop Bit (8, N, 1)
Services with E-Mail Support
e Prodigy: ACTI10B
¢ GEnie: ACTIVISION

Internet  support@activision.com or http:/www.activision.com

For information on how to use our listserver, please send e-mail to
CSbulletins@listserv.activision.com with the word “help” in the subject line. If
you're already familiar with listservers, send e-mail to the same address with the
word “index” in the subject line of your message for a list of files available from
this service.

FAx (310) 479-7355, 24 hours a day
FAXBACK (310) 473-6453, 24 hours a day
MaIL Activision Customer Support

P.O. Box 67713, Los Angeles, CA 90067

PHONE Call our 24-hour voice-mail system for answers to our most

frequently asked questions at (310) 479-5644. Or contact a
customer support representative at the same number between the
hours of 9:00 a.m. and 5:00 p.m. (Pacific Time) Monday through
Friday, except holidays.
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CusTOMER SUPPORT IN THE UK & AUSTRALIA

In the U.K,, please call 0990 143 525.
In Australia, please call 1902 962 000.

Or contact a customer support representative through the following online services.

ONLINE
Services with Activision Forums, E-Mail and File Library Support
e Microsoft Network: From any MSN window, pull down the Edit menu and
select Go to then Other Location.... At the prompt, type “Activision” and
click OK.
* CompuServe: 76004,2122 or [GO GAMBPUB]
e Activision BBS: (310) 479-1335 Up to 28,800 Baud;
Settings: 8 Bits, No Parity, 1 Stop Bit (8, N, 1)
Internet  support@activision.com or http:/www.activision.com
For information on how to use our listserver, please send e-mail to
CSbulletins@listserv.activision.com with the word “help” in the subject line. If
you are already familiar with listservers, send e-mail to the same address with
the word “index” in the subject line of your message for a list of files available
from this service.

Activision and Shanghai are registered trademarks of Activision, Inc. © 1996 Activision, Inc. The Kermit Head Logo,
JIM HENSON, MUPPET TREASURE ISLAND and all character names and likenesses are trademarks of
Jim Henson Productions, Inc. 1996 © Jim Henson Productions, Inc.
All rights reserved. All other trademarks and trade names are the properties of their respective holders.
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CREDITS

Producer and Director:

Art Director:

Digital Video Technical Director:
Executive Producers:

Lead Writer:

Dialogue:

Lead Programmer:
Programmers:
Technical Lead:
Game Design:

Audio Director and Sound Designer:
Original CD-ROM Musical Score:
Assistant Sound Designer:

Associate Producers:

Technical Production Coordinator:
Production Coordinator:

Production Assistant:

Production Designer and Lead Artist:

Mark Loparco

Nicholas Koenig

Daniel Bernstein

Cheryl Weiner, Steve Crane
Larry Kay

Craig Shemin, Ray De Laurentis,
Mark Loparco

James Edward Anhalt I11

Matt Spaloss, Dave DeVisser
Rachel Rubin

Mark Loparco, Daniel Bernstein, Nicholas
Koenig, Larry Kay, Cheryl Weiner
Michael B. Schwartz

Nathan Wang

Paul Supkoff

Daniel Bernstein, Greg Borrud
Brian Clarke

Adam Goldberg

Nadine Theuzillot

Nicholas Koenig
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Second Lead Artist:
Quantel Paintbox Artists:
Video Compositing Artists:

Animation Compositing Artists:
Artist Technical Lead:

Asset Manager:

Animation Supervisor:

Audio Production Assistant:
Video Specialist and Colorist:
2D Artists:

Digital Image Processing:

3D Modeling:

Quality Assurance Project Lead:
Windows Platform Lead:
Macintosh Platform Lead:
Quality Assurance Test Team:

Software Tools:

Package Design & Graphics:
Copywriter:
Documentation Manager:

Deborah Campbell

Andy Atkins, Gerit Vandenberg

Jon Tanimoto, Tom Mahoney, Nancy Matson,
Maja Dimitrejevic

Chris Friedberg, Mason Core

Rico Alexander

Daiva Venckus

Erika Walczak

S. Jenny Park

Huisok Pyon

Andres Moreta, Benjamin Naumann

Steve Kaplan, Curtis Shenton, Bryan Taylor
Anthony Longman, David Longman

Lisa Peterson Labon

Marty Stratton

Kip Stolberg

S. Jenny Park, Chris Strompolos, Anthony
Korotko, Glenn E. Jost, Brian Jennings

Brad Pickering
Jim Bridges, Eric Jensen, Cindy Whitlock
Veronica Milito
Michael Rivera
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MUPPET PERFORMERS
Frank Oz Bill Barretta
Steve Whitmire Bruce Lanoil
Dave Goelz John Kennedy
Jerry Nelson Louise Gold
Kevin Clash Mark Mansfield

SONGs
“Shiver My Timbers”
“Something Better”
“Sailing for Adventure”
“Cabin Fever”
“Professional Pirate”
“Love Led Us Here”

Written By Barry and Cynthia Weil
Muppet Treasure Island

film clips courtesy of Walt Disney Pictures

© Jim Henson Productions, Inc. 1996




ACTIVISION Limited 90-Day Warranty

mwwnmmmdmmmmmummmmummuwuu
free from defects in material and workmanship for 90 days from the date of purchase. If the recording medium is found defective within 90 days of oniginal purchase,
ACTIVISION agrees to replace, free of charge, any product discovered 1o be defective within such period upon receipt at its Factory Service Center of the product, postage
pad, with proof of date of purchase, as long as the program s stil being manufactured by ACTIVISION. In the event that the program is no longer avadable, ACTIVISION
mummm.wmawumm

This warranty is limited to the recording medi provded by ACTIVISION and is not appiicable 10 normal wear and tear. This
mumnwmuumluwr-mmmmm«mwmmwwr-mn
limited to the 90-day period described above.

To receive a replacement, you shoukd enclose the original product disks only, in ging by (1) a brief the defect, (2) your
mmmmmmumdwwuw
Please see the special "RETURNS™ further Call ACTMISION Customer Support at one of the numbers shown below.

POSSESSION, USE, OR MALFUNCTION OF THIS PRODUCT, INCLUDING DAMAGE TO PROPERTY AND, TO THE EXTENT PERMITTED BY LAW, DAMAGES FOR
PERSONAL INJURY, EVEN IF ACTIVISION HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES DO NOT ALLOW LIMITATIONS ON HOW
LONG AN IMPUED WARRANTY LASTS AND/OR THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS
AND/OR EXCLUSION OR LIMITATION OF LIABILITY MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER
RIGHTS WHICH VARY FROM STATE TO STATE.

After the warranty period, a defective Activision CD or floppy disk may be retumed to Activision with a check or money order for $7 U.S. (AUD$12.00 for Australia, or
£7.00 for Europe) cummency per CD or floppy disk for replacement (must be within one year of purchase).
RETURNS: Certified mail is recommended for retums. For best sarvice, please be sure to—
. Send the orignal product disks only, in protective packaging.
Enclose a photocopy of your dated sales receipt.
Enclose your name and retum address, typed or printed clearly, inside the package.
Enclose a brief note describing the problems) you have encountered with the software with the name of the product and the brand and model name or model

W

number of your computer.
In the U.S. send to: In Europe send to: In Australia send to:
WARRANTY REPLACEMENTS WARRANTY REPLACEMENTS WARRANTY REPLACEMENTS
ACTIVISION ACTVISION ACTMSION
P.0. Box 67713 Long Island House, 3A P.0.Box 873
Los Angeles, CA 90067, USA 1/4 Warple Way Epping, NSW 2121, Australia
(310) 479-5644 London, W3 ORQ, United Kingdom Disc Replacement: 612 9869 0955

Disc Replacement: 0181 742 9400

COPYRIGHT: The enclosed software product is copyrighted and all rights are reserved by Activision, Inc. It is published exclusively by Activision, Inc. The distribution of this

product is intended for the use of the onginal purchaser only and for use only on the computer system specified. Lawful users of this program are hereby licensed only to
read the program from its medium info memory of a computer solely for the purpose of executing the program. Copying (except for one backup copy on those systems
which provide for it), selling, or ; riby this product is a violation of the law. This manual and all other documentation contaned heresn are
copyrighted and all rights reserved by Activision, Inc. These documents may not, in whole or in part, be copied, photocopied, reproduced, translated, or reduced to any
slectronic medium or machine-readabie form without prior consent, in writing, from Activision, Inc. Wilful violations of the Copyright Law of the United States can result in
vl damages of up 1o $50,000 in addition 1o actual damages, plus criminal penalties of up 1o one year imprisonment and/or a $10,000 fine. In addition, violations of the
Copyright law of other jurisdictions may result in civil damages and, in certain circumstances, criminal penalties.

© 1996 Activision, Inc. Printed in the USA.




Muppet Treasure Island™ CD-ROM Registration Card

For better service, please take a few moments to fill out this card and return it.
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Place of purch

Player’s age: OM OF Purchaser's age: OM OF
About your computer: [} IBM Compatible [ Macintosh [ Power Mac [J Other.
Processor: 1386 (1486 (168030 [168040 [IPentium [JPowerPC [ Other Speed: ___ MHz

Memory: CJ12MB CJ4MB CI8MB [J1Over8 MB Hard Drive Size: MB

Disc Drive(s): (]5.25" (135" CJCD-ROMdrive Graphics: [JVGA [J]Super VGA [JMac Color [JMac B/W
Peripherals: [ Joystick [ Mouse Modem Speed: [] 2400 Baud (19600 [0 14,400 (128,800 [JOther
Operating System: [1DOS [JWindows [lMac [ Other
Sound Card: [JAd Lib [JSound Blaster [ Roland [ Media Vision [ Other

Preferred Game Type: (] Action []Adventure []Role playing [J Sports [ Simulation [ Education
[ Kids Ent. [ Strategy [ Other

Video game machines in your home: [ Super Nintendo Entertainment System [ Sega Genesis [ Sega CD
] Sega Saturn [J Sony Playstation [J Atari Jaguar [J 3DO [ Game Boy [] Game Gear [ Other

How many computer games do you own? Game cartridges?
What magazines do you read?
Children in household? [Yes "INo Age(s)
Where did you hear about our product? [ Store shelf [ Friend [ Magazine [ Other =




